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Chapter 445 

Tests for the Ratio of 
Two Means 
Introduction 
This procedure calculates power and sample size for t-tests from a parallel-groups design in which the logarithm of 
the outcome is a continuous normal random variable. This routine deals with the case in which the statistical 
hypotheses are expressed in terms of mean ratios instead of mean differences.  

The details of testing two treatments using data from a two-group design are given in another chapter, and they will 
not be repeated here. If the logarithms of the responses can be assumed to follow a normal distribution, hypotheses 
stated in terms of the ratio can be transformed into hypotheses about the difference. The details of this analysis are 
given in Julious (2004). They will only be summarized here. 

Testing Using Ratios 
It will be convenient to adopt the following specialized notation for the discussion of these tests. 
 

Parameter PASS Input/Output Interpretation 
𝜇𝜇𝑇𝑇 Not used Treatment mean. This is the treatment (group 1) mean. 

𝜇𝜇𝑅𝑅 Not used Reference mean. This is the reference (group 2) mean.  

𝜙𝜙0 R0 Null ratio. This is the value of 𝜙𝜙 = 𝜇𝜇𝑇𝑇/𝜇𝜇𝑅𝑅 under the null hypothesis, 𝐻𝐻0. 

𝜙𝜙 R1 Actual ratio. This is the value of 𝜙𝜙 = 𝜇𝜇𝑇𝑇/𝜇𝜇𝑅𝑅 at which the power is 
calculated. 

 

Note that the actual values of 𝜇𝜇𝑇𝑇 and 𝜇𝜇𝑅𝑅 are not needed. Only the ratio of these values is needed for power and 
sample size calculations. 

In the two-sided case, the null and alternative hypotheses are  

𝐻𝐻0:𝜙𝜙 = 𝜙𝜙0     versus     𝐻𝐻1:𝜙𝜙 ≠ 𝜙𝜙0. 

The one-sided hypotheses are 

𝐻𝐻0:𝜙𝜙 ≤ 𝜙𝜙0     versus     𝐻𝐻1:𝜙𝜙 > 𝜙𝜙0 

and 

𝐻𝐻0:𝜙𝜙 ≥ 𝜙𝜙0     versus     𝐻𝐻1:𝜙𝜙 < 𝜙𝜙0. 
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Log-Transformation 
In many cases, hypotheses stated in terms of ratios are more convenient than hypotheses stated in terms of 
differences. This is because ratios can be interpreted as percentages, but differences must be interpreted as actual 
amounts in their original scale. Hence, it has become a common practice to take the following steps in hypothesis 
testing.  

1. State the statistical hypotheses in terms of the ratio of the means. 

2. Transform this into hypotheses about a difference by taking logarithms. 

3. Analyze the logged data—that is, do the analysis in terms of the difference. 

4. Draw the conclusion in terms of the ratio. 

The details of step 2 for the two-sided null hypothesis are as follows: 

𝐻𝐻0:𝜙𝜙 = 𝜙𝜙0    ⇒    𝐻𝐻0:
𝜇𝜇𝑇𝑇
𝜇𝜇𝑅𝑅

= 𝜙𝜙0    ⇒    𝐻𝐻0: ln(𝜇𝜇𝑇𝑇) − ln(𝜇𝜇𝑅𝑅) = ln(𝜙𝜙0) 

Thus, a hypothesis about the ratio of the means on the original scale can be translated into a hypothesis about the 
difference of two means on the logged scale.  

Coefficient of Variation 
The coefficient of variation (COV) is the ratio of the standard deviation to the mean. This parameter can be used 
to represent the variation in the data because of a unique relationship that it has in the case of log-normal data.  

Suppose the variable X is the logarithm of the original variable Y. That is, X = ln(Y) and Y = exp(X). Label the 
mean and variance of X as 𝜇𝜇𝑋𝑋 and 𝜎𝜎𝑋𝑋2, respectively. Similarly, label the mean and variance of Y as 𝜇𝜇𝑌𝑌 and 𝜎𝜎𝑌𝑌2, 
respectively. If X is normally distributed, then Y is log-normally distributed. Julious (2004) presents the following 
well-known relationships between these two variables 

𝜇𝜇𝑌𝑌 = 𝑒𝑒𝜇𝜇𝑋𝑋+
𝜎𝜎𝑋𝑋
2

2  

𝜎𝜎𝑌𝑌2 = 𝜇𝜇𝑌𝑌2 �𝑒𝑒𝜎𝜎𝑋𝑋
2
− 1� 

From this relationship, the coefficient of variation of Y can be found to be  

𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌 =
�𝜇𝜇𝑌𝑌2�𝑒𝑒𝜎𝜎𝑋𝑋

2 − 1�

𝜇𝜇𝑌𝑌
 

= �𝑒𝑒𝜎𝜎𝑋𝑋2 − 1 

Solving this relationship for 𝜎𝜎𝑋𝑋2, the standard deviation of X can be stated in terms of the coefficient of variation of 
Y as 

𝜎𝜎𝑋𝑋 = �ln(𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1) 

Similarly, the mean of X is 

𝜇𝜇𝑋𝑋 = ln �
𝜇𝜇𝑌𝑌

�𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1
� 

Thus, the hypotheses can be stated in the original (Y) scale and then the power can be analyzed in the transformed 
(X) scale. For parallel-group designs, 𝜎𝜎𝑋𝑋2 = 𝜎𝜎𝑑𝑑2, the average variance used in the t-test of the logged data.  
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Power Calculation 
As is shown above, the hypotheses can be stated in the original (Y) scale using ratios or the logged (X) scale 
using differences. In either case, the power and sample size calculations are made using the formulas for testing 
the difference in two means. These formulas are presented in another chapter and are not duplicated here. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains the parameters associated with this test such as the ratios, sample sizes, alpha, and power. 

Solve For 

Solve For 
This option specifies the parameter to be solved for from the other parameters. In most situations, you will select 
either Power or Sample Size (N1). 

Test 

Alternative Hypothesis 
This option specifies the alternative hypothesis. This implicitly specifies the direction of the hypothesis test. 
Possible selections are: 

• Two-Sided (H1: R ≠ R0) 
This is the most common selection. It yields the two-tailed t-test.  

• One-Sided (H1: R < R0) 
This option yields a one-tailed t-test.  

• One-Sided (H1: R > R0) 
This option yields a one-tailed t-test.  

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of 
equal means when in fact the means are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.  
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Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal 
means when in fact the means are equal.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that 
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents 
the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size (When Solving for Sample Size) 

Group Allocation 
Select the option that describes the constraints on N1 or N2 or both. 

The options are 

• Equal (N1 = N2) 
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both 
sample sizes at once, no additional sample size parameters need to be entered. 

• Enter N2, solve for N1 
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note 
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power. 

• Enter R = N2/N1, solve for N1 and N2 
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2, 
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is  

N2 = R * N1. 

• Enter percentage in Group 1, solve for N1 and N2 
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS 
determines the needed N1 and N2 with this percentage to obtain the desired power. 

N2 (Sample Size, Group 2) 
This option is displayed if Group Allocation = “Enter N2, solve for N1” 

N2 is the number of items or individuals sampled from the Group 2 population. 

N2 must be ≥ 2. You can enter a single value or a series of values. 

R (Group Sample Size Ratio) 
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.” 

R is the ratio of N2 to N1. That is, 

R = N2 / N1. 

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this 
ratio are considered. 

N2 is related to N1 by the formula: 

N2 = [R × N1], 

where the value [Y] is the next integer ≥ Y. 
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For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 = 
10 and N2 = 20, or N1 = 50 and N2 = 100). 

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can 
enter a single or a series of values. 

Percent in Group 1 
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.” 

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2. 
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified 
percentage may occur due to the discrete nature of sample sizes. 

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values. 

Sample Size (When Not Solving for Sample Size) 

Group Allocation 
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2. 

The options are 

• Equal (N1 = N2) 
This selection is used when you wish to have equal sample sizes in each group. A single per group sample 
size will be entered. 

• Enter N1 and N2 individually 
This choice permits you to enter different values for N1 and N2. 

• Enter N1 and R, where N2 = R * N1 
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1. 

• Enter total sample size and percentage in Group 1 
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N, 
and then N2 as N - N1.  

Sample Size Per Group 
This option is displayed only if Group Allocation = “Equal (N1 = N2).” 

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value 
for N2. 

The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values. 

N1 (Sample Size, Group 1) 
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 = 
R * N1.” 

N1 is the number of items or individuals sampled from the Group 1 population.  

N1 must be ≥ 2. You can enter a single value or a series of values. 
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N2 (Sample Size, Group 2) 
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.” 

N2 is the number of items or individuals sampled from the Group 2 population. 

N2 must be ≥ 2. You can enter a single value or a series of values. 

R (Group Sample Size Ratio) 
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.” 

R is the ratio of N2 to N1. That is, 

R = N2/N1 

Use this value to obtain N2 as a multiple (or proportion) of N1. 

N2 is calculated from N1 using the formula: 

N2=[R x N1], 

where the value [Y] is the next integer ≥ Y. 

For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1. 

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can 
enter a single value or a series of values. 

Total Sample Size (N) 
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.” 

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of 
the total sample size in Group 1, implicitly defines N1 and N2. 

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample 
size needs to be at least 2. 

You can enter a single value or a series of values. 

Percent in Group 1 
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.” 

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified 
percentage may occur due to the discrete nature of sample sizes. 

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of 
values. 

Effect Size – Ratios 

R0 (Ratio | H0) 
This is the value of the ratio of the two means assumed by the null hypothesis, H0. Usually, R0 = 1.0 which 
implies that the two means are equal. However, you may test other values of R0 as well. Strictly speaking, any 
positive number is valid, but values near to, or equal to, 1.0 are usually used. 

Warning: you cannot use the same value for both R0 and R1. 
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R1 (Actual Ratio) 
This is the value of the ratio of the two means at which the power is to be calculated. Often, a range of values will 
be tried. For example, you might try the four values: 

1.05 1.10 1.15 1.20 

Strictly speaking, any positive number is valid. However, numbers between 0.50 and 2.00 are usually used. 

Warning: you cannot use the same value for both R0 and R1. 

Effect Size – Coefficient of Variation 

COV (Coefficient of Variation) 
The coefficient of variation is the ratio of the standard deviation and the mean (SD/Mean). It is used to specify the 
variability (standard deviation). Note that this COV is defined on the original (not logarithmic) scale. This value 
must be determined from past experience or from a pilot study. 

To be clear, consider the following definition. Suppose data on a response variable Y are collected. This 
procedure assumes that the values of X = Ln(Y) are analyzed using a two-sample t-test. Thus, there are two sets 
of means and standard deviations: those of X labelled MX and SX and those of Y labelled MY and SY. The COV 
entered here is the COV of Y = SY/MY. For log-normal data, the following relationship exists: COV(Y) = 
SQR(Exp(SX*SX)-1) where SX is the standard deviation of the log-transformed values. 
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Example 1 – Finding Power 
A company has developed a generic drug for treating rheumatism and wants to show that it is better than the 
standard drug. From previous studies, responses for either treatment are known to follow a lognormal distribution. 
A parallel-group design will be used and the logged data will be analyzed with a one-sided, two-sample t-test.   

Past experience leads the researchers to set the COV to 1.20. The significance level is 0.025. The power will be 
computed for R1 equal 1.10 and 1.20. Sample sizes between 100 and 900 will be examined in the analysis. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Tests for the Ratio of Two Means procedure window by expanding Means, then Two 
Independent Means, then clicking on Ratio Test, and then clicking on Tests for the Ratio of Two Means. You 
may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and 
choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Alternative Hypothesis ............................ One-Sided (H1: R > R0) 
Alpha ....................................................... 0.025 
Group Allocation ..................................... Equal (N1 = N2) 
Sample Size Per Group .......................... 100 to 900 by 200 
R0 (Ratio | H0) ........................................ 1.0 
R1 (Actual Ratio) .................................... 1.1 1.2 
COV (Coefficient of Variation) ................ 1.2 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for a T-Test ──────────────────────────────────────────────────── 
R = Treatment Mean / Reference Mean 
Hypotheses: H0: R1 ≤ R0   vs.   H1: R1 > R0 
 
       Effect  
Power N1 N2 N R0 R1 COV Size Alpha 
0.10568 100 100 200 1.000 1.100 1.200 0.101 0.025 
0.23392 300 300 600 1.000 1.100 1.200 0.101 0.025 
0.35811 500 500 1000 1.000 1.100 1.200 0.101 0.025 
0.47146 700 700 1400 1.000 1.100 1.200 0.101 0.025 
0.57180 900 900 1800 1.000 1.100 1.200 0.101 0.025 
0.27374 100 100 200 1.000 1.200 1.200 0.193 0.025 
0.65562 300 300 600 1.000 1.200 1.200 0.193 0.025 
0.86253 500 500 1000 1.000 1.200 1.200 0.193 0.025 
0.95061 700 700 1400 1.000 1.200 1.200 0.193 0.025 
0.98359 900 900 1800 1.000 1.200 1.200 0.193 0.025 
 
References 
Chow, S.C., Shao, J., Wang, H., and Lokhnygina, Y. 2018. Sample Size Calculations in Clinical Research, Third 
   Edition. Taylor & Francis/CRC. Boca Raton, Florida. 
Julious, Steven A. 2004. 'Tutorial in Biostatistics. Sample sizes for clinical trials with Normal data.' 
   Statistics in Medicine, 23:1921-1986. 
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Report Definitions 
Power is the probability of rejecting a false null hypothesis. 
N1 and N2 are the number of items sampled from each population. 
N is the total sample size, N1 + N2. 
R0 is the ratio of the means (μ1/μ2) under the null hypothesis, H0. R1 is the ratio of the means (μ1/μ2) at 
   which the power is calculated. 
COV is the coefficient of variation on the original scale. The value of σ is calculated from this. 
The effect size is equal to |Ln(R0) - Ln(R1)|/σ. 
Alpha is the probability of rejecting a true null hypothesis. 
 
 
Summary Statements ───────────────────────────────────────────────────────── 
A one-sided, two-sample t-test with group sample sizes of 100 and 100 achieves 11% power to 
detect a ratio of 1.100 when the ratio under the null hypothesis is 1.000. The coefficent of 
variation on the original scale is 1.200. The significance level (alpha) is 0.025. 

 

This report shows the power for the indicated scenarios.  

Plots Section 
 

      
 

These plots show the relationship of power to sample size for the two values of R1. 
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Example 2 – Validation 
We will validate this procedure by showing that it gives the identical results to the regular test on differences—a 
procedure that has been validated. We will use the same settings as those given in Example 1. Since the output for 
this example is shown above, only the output from the procedure that uses differences is shown below.   

To run the power analysis of a t-test on differences, we need the values of δ and σ. 

𝛿𝛿 = ln(𝑅𝑅1) 

= ln(1.1) 

= 0.095310 

𝛿𝛿 = ln(𝑅𝑅1) 

= ln(1.2) 

= 0.182322 

𝜎𝜎 = �ln(𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1) 

= ln(1.22 + 1) 

= 0.944456 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Two-Sample T-Tests Assuming Equal Variance procedure window by expanding Means, 
then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample T-Tests 
Assuming Equal Variance. You may then make the appropriate entries as listed below, or open Example 7 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Alternative Hypothesis ............................ One-Sided 
Alpha ....................................................... 0.025 
Group Allocation ..................................... Equal (N1 = N2) 
Sample Size Per Group .......................... 100 to 900 by 200 
Input Type ............................................... Difference 
δ .............................................................. 0.095310 0.182322 
σ .............................................................. 0.944456 
Reports Tab 
Means, Difference Decimals ................... 6 
Standard Deviation Decimals ................. 4 

Plot Text Tab 
Means, Difference Decimals ................... 6 
Standard Deviation Decimals ................. 4 
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Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for an Equal-Variance T-Test ───────────────────────────────────────── 
δ = μ1 - μ2 
Hypotheses:   H0: δ ≤ 0   vs.   H1: δ > 0 
 
Power N1 N2 N δ σ Alpha 
0.10568 100 100 200 0.095310 0.9445 0.025 
0.23392 300 300 600 0.095310 0.9445 0.025 
0.35811 500 500 1000 0.095310 0.9445 0.025 
0.47145 700 700 1400 0.095310 0.9445 0.025 
0.57180 900 900 1800 0.095310 0.9445 0.025 
0.27374 100 100 200 0.182322 0.9445 0.025 
0.65562 300 300 600 0.182322 0.9445 0.025 
0.86253 500 500 1000 0.182322 0.9445 0.025 
0.95061 700 700 1400 0.182322 0.9445 0.025 
0.98359 900 900 1800 0.182322 0.9445 0.025 
 

You can compare these power values with those shown above in Example 1 to validate the procedure. You will 
find that the power values are identical. 
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